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Publication Information
The information in this manual applies only to the MUSE System Version 8.0. It does not apply to earlier product versions. Due to continuing
product innovation, specifications in this manual are subject to change without notice.

MUSE and MAC are trademarks owned by GE Medical Systems Information Technologies, Inc., a General Electric Company going to market
as GE Healthcare. All other trademarks contained herein are the property of their respective owners.

This product complies with the requirements concerning medical devices from the following regulatory bodies:

The document part number and revision are at the bottom of each page. The revision identifies the document’s update level. The revision
history of this document is summarized in the following table.

Revision Date Comments

A 25 February 2014 Customer release.

To access other GE Healthcare Diagnostic Cardiology manuals, go to the Common Documentation Library (CDL), located at
http://www.gehealthcare.com/usen/service/biomed_tech_selfservice/services_user_doc/products/support.html, and click Cardiology.

To access Original Equipment Manufacturer (OEM) manuals, go to the device manufacturer's Web site.

Service Manual Language Information

WARNING

(EN)
This service manual is available in English only.

• If a customer's service provider requires a language other than English, it is the customer's
responsibility to provide translation services.

• Do not attempt to service the equipment unless this service manual has been consulted
and is understood.

• Failure to heed this warning may result in injury to the service provider, operator, or patient,
from electric shock, mechanical or other hazards.

ПРЕДУПРЕЖДЕНИЕ

(BG)
Това упътване за работа е налично само на английски език.

• Ако доставчикът на услугата на клиента изиска друг език, задължение на клиента е
да осигури превод.

• Не използвайте оборудването, преди да сте се консултирали и разбрали упътването
за работа.

• Неспазването на това предупреждение може да доведе до нараняване на доставчика
на услугата, оператора или пациент в резултат на токов удар или механична или
друга опасност.

警告
ZH-CN

本维修手册仅提供英文版本。

• 如果维修服务提供商需要非英文版本，客户需自行提供翻译服务。

• 未详细阅读和完全理解本维修手册之前，不得进行维修。

• 忽略本警告可能对维修人员，操作员或患者造成触电、机械伤害或其他形式的伤害。

警告
(ZH-TW)

本維修手冊只提供英文版。

• 如果客戶的維修人員有英語以外的其他語言版本需求，則由該客戶負責提供翻
譯服務。

• 除非您已詳閱本維修手冊並了解其內容，否則切勿嘗試對本設備進行維修。

• 不重視本警告可能導致維修人員、操作人員或病患因電擊、機械因素或其他因素
而受到傷害。
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Service Manual Language Information (cont'd.)

UPOZORENJE

(HR)
Ove upute za servisiranje dostupne su samo na engleskom jeziku.

• Ukoliko korisnički servis zahtijeva neki drugi jezik, korisnikova je odgovornost osigurati
odgovarajući prijevod.

• Nemojte pokušavati servisirati opremu ukoliko niste konzultirali i razumjeli ove upute.

• Nepoštivanje ovog upozorenja može rezultirati ozljedama servisnog osoblja, korisnika ili
pacijenta prouzročenim električnim udarom te mehaničkim ili nekim drugim opasnostima.

VAROVÁNÍ

(CS)

Tento provozní návod existuje pouze v anglickém jazyce.

• V případě, že externí služba zákazníkům potřebuje návod v jiném jazyce, je zajištění
překladu do odpovídajícího jazyka úkolem zákazníka.

• Nesnažte se o údržbu tohoto zařízení, aniž byste si přečetli tento provozní návod a
pochopili jeho obsah.

• V případě nedodržování této varování může dojít k poranění pracovníka prodejního
servisu, obslužného personálu nebo pacientů vlivem elektrického proudu, respektive
vlivem mechanických či jiných rizik.

ADVARSEL

(DA)
Denne servicemanual findes kun på engelsk.

• Hvis en kundes tekniker har brug for et andet sprog end engelsk, er det kundens ansvar
at sørge for oversættelse.

• Forsøg ikke at servicere udstyret medmindre denne servicemanual har været konsulteret
og er forstået.

• Manglende overholdelse af denne advarsel kan medføre skade på grund af elektrisk,
mekanisk eller anden fare for teknikeren, operatøren eller patienten.

WAARSCHUWING

(NL)
Deze service manual is alleen in het Engels verkrijgbaar.

• Indien het onderhoudspersoneel een andere taal nodig heeft, dan is de klant
verantwoordelijk voor de vertaling ervan.

• Probeer de apparatuur niet te onderhouden voordat deze service manual geraadpleegd
en begrepen is.

• Indien deze waarschuwing niet wordt opgevolgd, zou het onderhoudspersoneel, de
gebruiker of een patiënt gewond kunnen raken als gevolg van een elektrische schok,
mechanische of andere gevaren.

HOIATUS

(ET)
Käesolev teenindusjuhend on saadaval ainult inglise keeles.

• Kui klienditeeninduse osutaja nõuab juhendit inglise keelest erinevas keeles, vastutab
klient tõlketeenuse osutamise eest.

• Ärge üritage seadmeid teenindada enne eelnevalt käesoleva teenindusjuhendiga
tutvumist ja sellest aru saamist.

• Käesoleva hoiatuse eiramine võib põhjustada teenuseosutaja, operaatori või patsiendi
vigastamist elektrilöögi, mehaanilise või muu ohu tagajärjel.

VAROITUS

(FI)
Tämä huolto-ohje on saatavilla vain englanniksi.

• Jos asiakkaan huoltohenkilöstö vaatii muuta kuin englanninkielistä materiaalia, tarvittavan
käännöksen hankkiminen on asiakkaan vastuulla.

• Älä yritä korjata laitteistoa ennen kuin olet varmasti lukenut ja ymmärtänyt tämän
huolto-ohjeen.

• Mikäli tätä varoitusta ei noudateta, seurauksena voi olla huoltohenkilöstön, laitteiston
käyttäjän tai potilaan vahingoittuminen sähköiskun, mekaanisen vian tai muun
vaaratilanteen vuoksi.
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Service Manual Language Information (cont'd.)

ATTENTION

(FR)
Ce manuel technique n'est disponible qu'en anglais.

• Si un service technique client souhaite obtenir ce manuel dans une autre langue que
l'anglais, il devra prendre en charge la traduction et la responsabilité du contenu.

• Ne pas tenter d'intervenir sur les équipements tant que le manuel technique n'a pas été
consulté et compris.

• Le non-respect de cet avertissement peut entraîner chez le technicien, l'opérateur ou le
patient des blessures dues à des dangers électriques, mécaniques ou autres.

WARNUNG

(DE)
Diese Serviceanleitung ist nur in englischer Sprache verfügbar.

• Falls der Kundendienst eine andere Sprache benötigt, muss er für eine entsprechende
Übersetzung sorgen.

• Keine Wartung durchführen, ohne diese Serviceanleitung gelesen und verstanden zu
haben.

• Bei Zuwiderhandlung kann es zu Verletzungen des Kundendiensttechnikers, des
Anwenders oder des Patienten durch Stromschläge, mechanische oder sonstige Gefahren
kommen.

ΠΡΟΕΙΔΟΠΟΙΗΣΗ

(EL)
Το παρόν εγχειρίδιο σέρβις διατίθεται στα αγγλικά μόνο.

• Εάν το άτομο παροχής σέρβις ενός πελάτη απαιτεί το παρόν εγχειρίδιο σε γλώσσα εκτός
των αγγλικών, αποτελεί ευθύνη του πελάτη να παρέχει υπηρεσίες μετάφρασης.

• Μην επιχειρήσετε την εκτέλεση εργασιών σέρβις στον εξοπλισμό εκτός εάν έχετε
συμβουλευτεί και έχετε κατανοήσει το παρόν εγχειρίδιο σέρβις.

• Εάν δεν λάβετε υπόψη την προειδοποίηση αυτή, ενδέχεται να προκληθεί τραυματισμός
στο άτομο παροχής σέρβις, στο χειριστή ή στον ασθενή από ηλεκτροπληξία, μηχανικούς
ή άλλους κινδύνους.

FIGYELMEZTETÉS

(HU)

Ez a szerviz kézikönyv kizárólag angol nyelven érhető el.

• Ha a vevő szerviz ellátója angoltól eltérő nyelvre tart igényt, akkor a vevő felelőssége
a fordítás elkészíttetése.

• Ne próbálja elkezdeni használni a berendezést, amíg a szerviz kézikönyvben leírtakat
nem értelmezték és értették meg.

• Ezen figyelmeztetés figyelmen kívül hagyása a szerviz ellátó, a működtető vagy a páciens
áramütés, mechanikai vagy egyéb veszélyhelyzet miatti sérülését eredményezheti.

AÐVÖRUN

(IS)

Þessi þjónustuhandbók er eingöngu fáanleg á ensku.

• Ef að þjónustuveitandi viðskiptamanns þarfnast annars tungumáls en ensku, er það skylda
viðskiptamanns að skaffa tungumálaþjónustu.

• Reynið ekki að afgreiða tækið nema þessi þjónustuhandbók hefur verið skoðuð og skilin.

• Brot á að sinna þessari aðvörun getur leitt til meiðsla á þjónustuveitanda, stjórnanda eða
sjúklingi frá raflosti, vélrænum eða öðrum áhættum.

PERINGATAN

(ID)
Manual servis ini hanya tersedia dalam bahasa Inggris.

• Jika penyedia jasa servis pelanggan memerlukan bahasa lain selain dari Bahasa Inggris,
merupakan tanggung jawab dari penyedia jasa servis tersebut untuk menyediakan
terjemahannya.

• Jangan mencoba melakukan servis terhadap perlengkapan kecuali telah membaca dan
memahami manual servis ini.

• Mengabaikan peringatan ini bisa mengakibatkan cedera pada penyedia servis, operator,
atau pasien, karena terkena kejut listrik, bahaya mekanis atau bahaya lainnya.

4 MUSE™ Cardiology Information System 2076576-008A
25 February 2014



Service Manual Language Information (cont'd.)

AVVERTENZA

(IT)
Il presente manuale di manutenzione è disponibile soltanto in Inglese.

• Se un addetto alla manutenzione richiede il manuale in una lingua diversa, il cliente è
tenuto a provvedere direttamente alla traduzione.

• Si proceda alla manutenzione dell'apparecchiatura solo dopo aver consultato il presente
manuale ed averne compreso il contenuto.

• Il non rispetto della presente avvertenza potrebbe far compiere operazioni da cui derivino
lesioni all'addetto, alla manutenzione, all'utilizzatore ed al paziente per folgorazione
elettrica, per urti meccanici od altri rischi.

警告
(JA)

このサービスマニュアルは英語版しかありません。

• サービスを担当される業者が英語以外の言語を要求される場合、翻訳作業はその業
者の責任で行うものとさせていただきます。

• このサービスマニュアルを熟読し、十分に理解をした上で装置のサービスを
行ってください。

• この警告に従わない場合、サービスを担当される方、操作員あるいは患者が、感電
や機械的又はその他の危険により負傷する可能性があります。

경고
(KO)

본서비스지침서는영어로만이용하실수있습니다.

• 고객의서비스제공자가영어이외의언어를요구할경우,번역서비스를제공하는것
은고객의책임입니다.

• 본서비스지침서를참고했고이해하지않는한은해당장비를수리하려고시도하
지마십시오.

• 이경고에유의하지않으면전기쇼크,기계상의혹은다른위험으로부터서비스제
공자,운영자혹은환자에게위해를가할수있습니다.

BRĪDINĀJUMS

(LV)
Šī apkalpotāju rokasgrāmata ir pieejama tikai angļu valodā.

• Ja apkalpošanas sniedzējam nepieciešama informācija citā, nevis angļu, valodā, klienta
pienākums ir nodrošināt tās tulkošanu.

• Neveiciet aprīkojuma apkopi, neizlasot un nesaprotot apkalpotāju rokasgrāmatu.

• Šī brīdinājuma neievērošana var radīt elektriskās strāvas trieciena, mehānisku vai citu risku
izraisītu traumu apkopes sniedzējam, operatoram vai pacientam.

ĮSPĖJIMAS

(LT)

Šis eksploatavimo vadovas yra prieinamas tik anglų kalba.

• Jei kliento paslaugų tiekėjas reikalauja vadovo kita kalba - ne anglų, numatyti vertimo
paslaugas yra kliento atsakomybė.

• Nemėginkite atlikti įrangos techninės priežiūros, nebent atsižvelgėte į šį eksploatavimo
vadovą ir jį supratote.

• Jei neatkreipsite dėmesio į šį perspėjimą, galimi sužalojimai dėl elektros šoko, mechaninių
ar kitų paslaugų tiekėjui, operatoriui ar pacientui.

ADVARSEL

(NO)
Denne servicehåndboken finnes bare på engelsk.

• Hvis kundens serviceleverandør trenger et annet språk, er det kundens ansvar å sørge
for oversettelse.

• Ikke forsøk å reparere utstyret uten at denne servicehåndboken er lest og forstått.

• Manglende hensyn til denne advarselen kan føre til at serviceleverandøren, operatøren
eller pasienten skades på grunn av elektrisk støt, mekaniske eller andre farer.
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Service Manual Language Information (cont'd.)

OSTRZEŻENIE

(PL)

Niniejszy podręcznik serwisowy dostępny jest jedynie w języku angielskim.

• Jeśli dostawca usług klienta wymaga języka innego niż angielski, zapewnienie usługi
tłumaczenia jest obowiązkiem klienta.

• Nie należy serwisować wyposażenia bez zapoznania się i zrozumienia niniejszego
podręcznika serwisowego.

• Niezastosowanie się do tego ostrzeżenia może spowodować urazy dostawcy usług,
operatora lub pacjenta w wyniku porażenia elektrycznego, zagrożenia mechanicznego
bądź innego.

AVISO

(PT-BR)
Este manual de assistência técnica só se encontra disponível em inglês.

• Se o serviço de assistência técnica do cliente não for GE, e precisar de outro idioma, será
da responsabilidade do cliente fornecer os serviços de tradução.

• Não tente reparar o equipamento sem ter consultado e compreendido este manual de
assistência técnica.

• O não cumprimento deste aviso pode por em perigo a segurança do técnico, operador ou
paciente devido a choques elétricos, mecânicos ou outros.

AVISO

(PT-PT)
Este manual técnico só se encontra disponível em inglês.

• Se a assistência técnica do cliente solicitar estes manuais noutro idioma, é da
responsabilidade do cliente fornecer os serviços de tradução.

• Não tente reparar o equipamento sem ter consultado e compreendido este manual
técnico.

• O não cumprimento deste aviso pode provocar lesões ao técnico, ao utilizador ou ao
paciente devido a choques eléctricos, mecânicos ou outros.

AVERTISMENT

(RO)
Acest manual de service este disponibil numai în limba engleză.

• Dacă un furnizor de servicii pentru clienţi necesită o altă limbă decât cea engleză, este de
datoria clientului să furnizeze o traducere.

• Nu încercaţi să reparaţi echipamentul decât ulterior consultării şi înţelegerii acestui
manual de service.

• Ignorarea acestui avertisment ar putea duce la rănirea depanatorului, operatorului sau
pacientului în urma pericolelor de electrocutare, mecanice sau de altă natură.

ПРЕДУПРЕЖДЕНИЕ

(RU)
Настоящее руководство по обслуживанию предлагается только на английском языке.

• Если сервисному персоналу клиента необходимо руководство не на английском, а на
каком-то другом языке, клиенту следует обеспечить перевод самостоятельно.

• Прежде чем приступать к обслуживанию оборудования, обязательно обратитесь к
настоящему руководству и внимательно изучите изложенные в нем сведения.

• Несоблюдение требований данного предупреждения может привести к тому, что
специалисты по обслуживанию, операторы или пациенты получат удар электрическим
током, механическую травму или другое повреждение.

UPOZORENJE

(SR)
Ovo servisno uputstvo je dostupno samo na engleskom jeziku.

• Ako klijentov serviser zahteva neki drugi jezik, klijent je dužan da obezbedi prevodilačke
usluge.

• Ne pokušavajte da opravite uređaj ako niste pročitali i razumeli ovo servisno uputstvo.

• Zanemarivanje ovog upozorenja može dovesti do povređivanja servisera, rukovaoca ili
pacijenta usled strujnog udara, ili mehaničkih i drugih opasnosti.
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Service Manual Language Information (cont'd.)

VAROVANIE

(SK)
Tento návod na obsluhu je k dispozícii len v angličtine.

• Ak zákazníkov poskytovateľ služieb vyžaduje iný jazyk ako angličtinu, poskytnutie
prekladateľských služieb je zodpovednosťou zákazníka.

• Nepokúšajte sa o obsluhu zariadenia skôr, ako si neprečítate návod na obsluhu a
neporozumiete mu.

• Zanedbanie tohto varovania môže vyústiť do zranenia poskytovateľa služieb, obsluhujúcej
osoby alebo pacienta elektrickým prúdom, mechanickým alebo iným nebezpečenstvom.

OPOZORILO

(SL)
Ta servisni priročnik je na voljo samo v angleškem jeziku.

• Če ponudnik storitve stranke potrebuje priročnik v drugem jeziku, mora stranka zagotoviti
prevod.

• Ne poskušajte servisirati opreme, če tega priročnika niste v celoti prebrali in razumeli.

• Če tega opozorila ne upoštevate, se lahko zaradi električnega udara, mehanskih ali drugih
nevarnosti poškoduje ponudnik storitev, operater ali bolnik.

ADVERTENCIA

(ES)
Este manual de servicio sólo existe en inglés.

• Si el encargado de mantenimiento de un cliente necesita un idioma que no sea el inglés, el
cliente deberá encargarse de la traducción del manual.

• No se deberá dar servicio técnico al equipo, sin haber consultado y comprendido este
manual de servicio.

• La no observancia del presente aviso puede dar lugar a que el proveedor de servicios, el
operador o el paciente sufran lesiones provocadas por causas eléctricas, mecánicas o
de otra naturaleza.

VARNING

(SV)
Den här servicehandboken finns bara tillgänglig på engelska.

• Om en kunds servicetekniker har behov av ett annat språk än engelska ansvarar kunden
för att tillhandahålla översättningstjänster.

• Försök inte utföra service på utrustningen om du inte har läst och förstår den här
servicehandboken.

• Om du inte tar hänsyn till den här varningen kan det resultera i skador på serviceteknikern,
operatören eller patienten till följd av elektriska stötar, mekaniska faror eller andra faror.

UYARI

(TR)
Bu servis kılavuzunun sadece İngilizcesi mevcuttur.

• Eğer müşteri teknisyeni bu kılavuzu İngilizce dışında bir başka lisandan talep ederse, bunu
tercüme ettirmek müşteriye düşer.

• Servis kılavuzunu okuyup anlamadan ekipmanlara müdahale etmeyiniz.

• Bu uyarıya uyulmaması, elektrik, mekanik veya diğer tehlikelerden dolayı teknisyen,
operatör veya hastanın yaralanmasına yol açabilir.
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Service Manual Language Information (cont'd.)

ЗАСТЕРЕЖЕННЯ

(UK)

Дане керівництво з сервісного обслуговування постачається виключно англійською мовою.

• Якщо сервісний інженер потребує керівництво іншою мовою, користувач зобов'язаний
забезпечити послуги перекладача.

• Не намагайтеся здійснювати технічне обслуговування даного обладнання, якщо
ви не читали, або не зрозуміли інформацію, надану в керівництві з сервісного
обслуговування.

• Недотримання цього застереження може призвести до травмування сервісного
інженера, користувача даного обладнання або пацієнта внаслідок електричного шоку,
механічного ушкодження або з інших причин невірного обслуговування обладнання.

CẢNH BÁO

(VI)

Tài Liệu Hướng Dẫn Sửa Chữa chỉ có bản tiếng Anh.

• Nếu các đơn vị cung cấp dịch vụ cho khách hàng yêu cầu một ngôn ngữ nào khác tiếng
Anh, thì khách hàng sẽ có trách nhiệm cung cấp các dịch vụ dịch thuật.

• Không được sửa chữa thiết bị trừ khi đã tham khảo và hiểu Tài liệu Hướng dẫn Sửa chữa.

• Không tuân thủ những cảnh báo này có thể dẫn đến các tổn thương cho người thực
hiện sửa chữa, người vận hành hay bệnh nhân, do sốc điện, các rủi ro về cơ khí hay
các rủi ro khác.
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1
Introduction

This chapter provides general information required for the proper use of the system
and this manual. Familiarize yourself with this information before using the system.

Manual Information
This section provides information for the correct use of this manual.

Keep this manual with the equipment at all times and periodically review it. You
should request training assistance from GE Healthcare, if needed.

Intended Audience
This manual is intended for use by GE Healthcare Field Service Engineers.

Manual Purpose
This manual provides the information needed to install and configure the Cloverleaf
Application Adapter - Web Services (CAA-WS). This manual also provides information
on troubleshooting.

Document Conventions
This manual uses the following conventions.

Typographical Conventions
Convention Description

Bold Text Indicates keys on the keyboard, text to enter, or hardware items such as
buttons or switches on the equipment.

Italicized-Bold
Text

Indicates software terms that identify menu items, buttons or options in
various windows.

CTRL+ESC Indicates a keyboard operation. A plus (+) sign between the names of two
keys indicates that while holding the first key, you should press and release
the second key. For example, Press CTRL+ESCmeans to press and hold the
CTRL key and then press and release the ESC key.
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Convention Description

<space> Indicates that you must press the spacebar. When instructions are given
for typing a precise text string with one or more spaces, the point where
you must press the spacebar is indicated as <space>. This ensures that
the correct number of spaces is inserted in the correct positions within
the literal text string. The purpose of the < > brackets is to distinguish the
command from the literal text within the string.

Enter Indicates that you must press the Enter or Return key on the keyboard. Do
not type Enter.

> The greater than symbol, or right angle bracket, is a concise method to
indicate a sequence of menu selections.
For example, the statement “From the main menu, select System > Setup >
Options to open the Option Activation window” replaces the following:
1. From the main menu, select System to open the Systemmenu.

2. From the Systemmenu, select Setup to open the Setupmenu.

3. From the Setupmenu, select Options to open the Option Activation
window.

Illustrations
All illustrations in the manual are provided as examples only. Depending on system
configuration, screens in the manual may differ from the screens on your system.

All patient names and data are fictitious. Any similarity to actual persons is
coincidental.

Notes
Notes provide application tips or additional information that, while useful, are not
essential to the correct operation of the system. They are called out from the body
text through a flag word and indentation, as follows:

NOTE:
The tip or additional information is indented below the NOTE flag word.

Related Documents
For a complete list of related manuals, refer to the Related Manuals appendix in the
MUSE Cardiology Information Systems Service Manual.

Additional Assistance
GE Healthcare maintains a trained staff of application and technical experts to answer
questions and respond to issues and problems that may arise during the installation,
maintenance, and use of this system.

Contact your local GE Healthcare representative to request additional assistance.
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Interface Overview
The Master-Patient Index (MPI) interface is composed of three components.

• Cloverleaf Application Adapter-Web Services (CAA-WS, the CCG web services) –
Used to establish a secure connection to the MPI server and handles authentication .

• hl7_soap_singreq/hl7_soap_multreq Cloverleaf Site – Used to translate between
HL7 message formats and the Web Service’s SOAP message format.

• muse_prod Cloverleaf Site – The standard MUSE CCG site used to interface with
the Hospital Information Systems (HIS).

From the MUSE standpoint, the ADT Query path is the same as when the MUSE is
connected to a HIS (via a CCG). The MUSE system sends a standard QRY^Q01 ADT
Query message to the CCG’s Cloverleaf MUSE site.

The Cloverleaf MUSE site then forwards the message to the hl7_soap_singreq or
hl7_soap_multreq site (also in Cloverleaf), which saves the MUSE Site ID of the
outgoing request and translates the QRY^Q01 HL7message into a SOAP message
appropriate for the MPI web server.

After the query message is converted to a SOAP message, the message is ready for
the MPI web server. The message negotiates web site security protocols, such as
https, and user authentication. CAA-WS completes these operations .

When the web site replies to the query, the response is returned to CAA-WS, which
forwards the response to the Cloverleaf hl7_soap_singreq or hl7_soap_multreq site.

The Cloverleaf hl7_soap_singreq or hl7_soap_multreq site converts the response
from the SOAP format into an HL7 ADT^A19message. After converting the response
message into an HL7 message, the hl7_soap_singreq or hl7_soap_multreq site
reattaches the MUSE Site ID to the message, and sends the A19 message to the MUSE
site. The MUSE site returns the response to the MUSE system as if it were a response
from a HIS.
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2
Connecting the MUSE System to a
Master-Patient Index Server (MPI)

NOTE:
Throughout this procedure you will notice some items are labeled with four X’s
(XXXX). Replace these X’s with a string that appropriately identifies the target MPI
site.

The configuration of MPI support (CCG CAA-WS: Cloverleaf Application Adapter Web
Services) requires the following:

• A text editor, such as MS Notepad or Notepad++. Do not use MS-Wordpad or
MS-Word.

• A validating XML editor (optional).

Complete the following tasks to install and configure a CCG system with CAA-WS.

1. Install a CCG system with Cloverleaf Application Adaptor Web Services (CAA-WS).
See “Installing CCG, MUSE Sites, and HL7 to Soap Template Cloverleaf Site” on
page 16.

2. Install the MUSE sites. See “Installing CCG, MUSE Sites, and HL7 to Soap Template
Cloverleaf Site” on page 16.

3. Install the HL7 to the soap template Cloverleaf site. See “Installing CCG, MUSE
Sites, and HL7 to Soap Template Cloverleaf Site” on page 16.

4. Create SSL security certificates (required only if https is used to access the web
service). See “Creating an SSL Security Certificate” on page 17.

5. Configure CAA-WS. See “Configuring Cloverleaf Application Adaptor Web Services
(CAA-WS)” on page 20.

6. Import schema documents specific to the MPI web site into Cloverleaf. See
“Importing an XML Schema into Cloverleaf” on page 25.

7. Configure Cloverleaf outbound translation of HL7 to SOAP request message.
See “Creating a Request Translation File” on page 30.

8. Configure Cloverleaf inbound translation of SOAP response message to HL7.
SeeAppendix “Creating a Request Translation File” on page 30.

9. Connect the MUSE site to the hl7_soap_singreq or hl7_soap_multreq site. See
“Connecting the MUSE Site to the hl7_soap_singreq Site” on page 36.

10. Finalize the configuration. See “Finalizing the Configuration” on page 44.

11. Perform cleanup. See “Performing Cleanup” on page 44.
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Installation and Configuration Procedures
Use the following procedures to install and configure the CCG, MUSE, Cloverleaf sites,
and creating an SSL Security Certificate.

Installing CCG, MUSE Sites, and HL7 to Soap Template
Cloverleaf Site

Use the following procedure to install the CCG, MUSE sites, and HL7 to Soap template
Cloverleaf site.

1. Install the CCG following the instructions in the MUSE Cardiology Information
System Installation Guide.

Autostart and Scheduling configuration are performed after the MPI interface is
created and configured.

2. After installing the CCG, copy the standard MUSE-CCG Interface zip files
from the CCG Sites directory on the MUSE V8 System Application DVD to
c:\gehc-it\ccg\extras\interfaces on the CCG server.

3. In the CCG Sites directory of the MUSE CCG CD, copy one of the following files to
c:\gehc-it\ccg\extras\interfaces on the CCG server:

• If more than one request has to be sent to the Web Service to request for
patient information, locate and copy hl7_soap_multreq.zip.

• If only one request has to be sent to the Web Service to request for patient
information, locate and copy hl7_soap_singreq.zip.

NOTE:
The default sites hl7_soap_multreq and hl7_soap_singreq include XML,
XSD and OCM files which are to be used as samples and will require you to
customize them for the customer. Refer to section “Creating a New SOAP
Client” on page 21 for generating new XML files. Refer to section “Generating
XSD Files” on page 27 for creating the required XSD files. OCM files are
generated when the XSD files are compiled.

4. Install the MUSE interfaces as required by the site following the procedures
documented in the MUSE Cardiology Information Systems Devices and Interfaces
Manual.

NOTE:
Only themuse_prod site (muse_prod.zip) is required by the MPI interface.

5. Install the HL7-to-soap site that you copied in step 3.

NOTE:
This document assumes that the hl7_soap_singreq site is installed. If the
hl7_soap_multreq site is installed, you can follow the same instructions as
for the hl7_soap_singreq site.
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6. In hl7–soap-singreq/tclprocs/http_query.tcl and hl7–soap-multreq/
tclprocs/http_query.tcl, procedure ExtractTokenAndRequestFindPatient, has
hard-coded details specific to the MPI server you are using.

Update the following fields as appropriate for the customer site.

• set UserName “webservice”

• set FriendlyName “WSGeApp”

• set SystemCode “GEApp”

• set SystemLocation “SG033827”

NOTE:
The Savehl7fields.tcl. has a delay configured to prevent a race condition
between two ADT query requests. Configure the delay as appropriate for
the customer site so that any two requests are processed one after the
other but as soon as possible. The delay configured is in milliseconds. In the
example below its configured as 10,000 milliseconds

Use the following information to configure the delay. If the patientID.txt
file exists, it indicates that a request is being processed and you will need
to wait until it is done.

if { [file exists "patientID.txt"] } {
#echo "inside IF loop"
after
10000
}

NOTE:
There is a known issue with the Savehl7fields.tcl in the hl7-soap-singreq
template which will be fixed in a subsequent release. In this template the
code uses a “while” block when it should have used an “If” block as the code
snippet shown above. A work around is to change the "while" to "if" or the
entire section of code writing the Patient ID to a file and reading from it
can be removed from this template.

7. Appropriate error handling needs to be added to the tclproc parsing the
response from the MPI Server.

Error handling is required in both cases: when TPS translation is used or when
the Clover Leaf XLATE is used.

8. The Source in the default alerts of all the templates will need to be modified
accordingly if the CCG / Cloverleaf install directory is not on drive C. The default
alert file for a site is located at CL_INSTALL_DIR\integrator\[SITENAME]\Alerts.

9. If the connection to the services uses a Secure Socklet Level (SSL) connection,
proceed to the next section “Creating an SSL Security Certificate”.

If the connection to the services does not use SSL, proceed to “Configuring
Cloverleaf Application Adaptor Web Services (CAA-WS)” on page 20.

Creating an SSL Security Certificate
If the connection to the service uses a Secure Socket Level (SSL) connection such as
https, you need to perform the following procedure to create a keystore that allows
CAA-WS to establish a secure connection to the Web Service.
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If there is no SSL connection, skip this section and proceed to “Configuring Cloverleaf
Application Adaptor Web Services (CAA-WS)” on page 20.

1. Obtain the security certificate for theWeb Services where patient data is obtained.
The following procedure is for Internet Explorer 8. The procedure for other
browsers may be similar.

a. Using Internet Explorer 8, navigate to the web address of the service.
The following error page is displayed: Certificate Error: Navigation Blocked.

b. Click on the following link: Continue to this website (not recommended).
The following message is displayed: Page cannot be found HTTP: 404 error.
Next to the URL drop-down field, the following message is displayed:
Certificate Error.

c. Click Certificate Error.

d. Click View Certificates.

e. Under Certificate Details, select Copy to File….

f. When the Certificate Export Wizard opens, click Next and select DER
encoded binary.

g. Click Next and navigate to a temporary directory.

h. Name the file XXXXCertificate.cer, replacing the XXXX with a name
appropriate to the MPI site.

i. Click Save.

j. Click Next > Finish to complete the security certificate export.

2. Copy the security certificate to a temporary directory on the CCG Server.

3. Open a command window and change to the directory where you saved your file.

4. In the command window, type the following command to create a keystore:
C:\gehc-it\_jre\bin\keytool –importcert –file XXXXCertificate.cer –storepass
PPPPPP –trustcacerts –storetype JKS –keystore XXXXKey.keystore
The keystore contains the certificate using the java key tool command replacing
PPPPPP with the password you are using to protect the keystore.

NOTE:
The password needs to be a minimum of six characters long. Remember the
password because it is required when editing the CAA-WS CCG configuration
file.

5. When the key tool runs, a dialog box asks if you trust the certificate; click YES.

6. Copy the keystore file, XXXXKey.keystore, to the C:\gehc-it\ccg\quovadx\cis6.0\
integrator\hl7_soap_multreq or C:\gehc-it\ccg\quovadx\cis6.0\integrator\
hl7_soap_singreq directory on the CCG Server.

7. Proceed to the next section “Converting a Certificate from P12 to JKS” .

Converting a Certificate from P12 to JKS

Use the following procedure to convert a security certificate from P12 to JKS. The
assumption is that you already have the certificate test.p12 of type PKCS12 and you
are converting it to test.JKS of type JKS.

1. First, you will need to determine the value to enter for -srcalias.

Open a command window and type the following:
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keytool -v -list -keystore test.p12 -storepass
<MyPassWord> -storetype PKCS12

NOTE:
For the variable <MyPassword> use the password for the test.p12
certificate.

The results are dependent on the language of the operating system, the
following is an example from a Swedish operating system:

In the example the value for -srcalias is rs ekg prod.

This command will also list the information of the Certificate Authority and
the certificate(s) used. This information will be useful for subsequent steps
(especially step 6) where you will have to obtain the required certificates.

See Appendix B “View Trusted Certificates” on page 61 for the information
on using the Microsoft Management Console mmc.exe to view the trusted
certificates installed on your machine.

2. To create the JKS from the P12 file, run the following command in the command
prompt:

keytool -importkeystore -srckeystore test.p12
-destkeystore test.jks -srcstoretype PKCS12
-deststoretype JKS -srcstorepass <password of P12>
-deststorepass <password of JKS> -srcalias <P12 alias>
-destalias <JKS alias> -srckeypass <P12 store password>
-destkeypass <JKS store password>

3. Confirm that the JKS was created successfully by running the following
command:

keytool -v -list -keystore test.jks -storetype jks

4. Enter the password when prompted.

The console lists the content of the JKS file.

5. Create a text file called certificate.pem in any text editor.

All the public certificates need to be in a single file. These include root,
intermediate, and CA certificates. Since P12 is a Windows-based certificate, all
certificates must be available.

6. Download or obtain all possible certificates from the client.
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7. Download and install Open SSL from the following location:
http://gnuwin32.sourceforge.net/packages/openssl.htm.

8. Open each available certificate, one-by-one, in any text editor.

The certificates (.cer/.crt file) should be Base 64 encoded so that you can use
them in the PEM file you created earlier. A Base 64 encoded certificate looks like
the following sample:

-----BEGIN CERTIFICATE-----
MIIFazCCA1OgAwIBAgIRAIC/
GIYrVi9G9NoHXIniK9EwDQYJKoZIhvcNAQEFBQAw
.
HDFQu+mEswKUJrN/
ug2rIThaKdqkwe9iVDI9yAZD6aF8P2WRO9q7IYgbAs4/F7Q=
-----END CERTIFICATE---–

• If the content is in this format, copy and paste it into the certificate.pem file.

NOTE:
You need to copy all of the content and tags between the Begin
Certificate and End Certificate tags.

• If the content is not in this format, you need to convert it into Base 64 using
Open SSL, which you downloaded and installed earlier. Use the following
command for each non-Base 64 encoded certificate:
openssl x509 -in xyz.crt -inform der -outform pem -out
abc.pem

9. Open the newly created PEM file and its content should be similar to the
example in step 8.

10. Copy and paste the content into the certificate.pem file.

11. Use the following command to import all of the certificates to the JKS file.

keytool -import -keystore test.jks -alias
muse-client-cert -file certificate.pem

a. Type the keystore password when prompted.

b. Type yes when prompted if you trust this certificate.

12. To confirm that the certificates imported successfully with JKS, run the following
command:

keytool -v -list -keystore test.jks -storetype jks

13. Proceed to the next section “Configuring Cloverleaf Application Adaptor Web
Services (CAA-WS)”.

Configuring Cloverleaf Application Adaptor Web
Services (CAA-WS)

Use the following procedures to configure the CAA-WS.
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Creating a New SOAP Client
Use the following procedure to create a new SOAP client.

1. At the C: drive, open the folder at C:\gehc-it\ccg\quovadx\cis6.0\
integrator\hl7_soap_multreq\javadriver\hl7_adt_soap_multreq\ or
C:\gehc-it\ccg\quovadx\cis6.0\integrator\hl7_soap_singreq\javadriver\
hl7_adt_soap_singreq file and rename CCG-CAAWS-config.xml with a different
name so that it is saved as a backup file to refer to later.

2. Open theWS Configurator tool.

Double-click the jar file from a file browser or run java -jar WSConfigurator.jar
from the command line after changing the directory to where
WSConfigurator.jar is located.

This is found at integrator/CAA/ws/tool/WSConfigurator.jar.

The Logical View window opens.

3. Select Client > New SOAP Client.

The Add SOAP Client window opens:

4. Enter theWSDL URL.

• Using a WSDL at an HTTP address can be unstable if the WSDL becomes
unavailable, causing the Client service to fail to start.

• It is recommended that you save a copy of a WSDL to the local hard drive
and access it from there.
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In the following example, the following WSDL is entered intoWSDL URL:
http://soap.amaqmzon.com/schemas2/AmazonWebSerices.wsdl.

5. Click Load WSDL.

The Service field is populated from the WSDL. Since there is only one entry,
the system automatically selects it.

Selecting a Service populates the Port field. Since there is only one port in the
example, it is autoselected.

6. Use the Address field for any address overrides.

In the example, the Address field is empty because the address in theWSDL
URL field is correct.

If the server implements a widely available WSDL based on a standard where
the address is generic, use the Address field to override it with the address of
the server with which this system is interacting.

7. Select the Service Mode > MESSAGE (by default the Service Mode is set to
PAYLOAD).

• MESSAGE

• Indicates the system user is sending and receiving the entire SOAP
Envelope.

• This allows greater flexibility, but is also more complicated and error prone.

• PAYLOAD

• This tells the system to send and receive only the contents of the SOAP
Body element and that CXF takes care of the SOAP Envelope/Header.

• Use PAYLOAD mode unless there is information in the SOAP Header that
the system needs to send, which CXF does not already handle.

8. Click OK.

9. Make sure the check box next to Message Logging Enabled is not selected
to prevent the large logs messages.

10. Select SOAPACTION for Cloverleaf TrxID Determination.

22 MUSE™ Cardiology Information System 2076576-008A

http://soap.amaqmzon.com/schemas2/AmazonWebSerices.wsdl


Connecting the MUSE System to a Master-Patient Index Server (MPI)

11. Click File > Save As.

The Save window opens.

12. Save the configuration file in the folder C:\gehc-it\ccg\quovadx\cis6.0\
integrator\hl7_soap_singreq\javadriver\hl7_adt_soap_singreq\ as
CCG-CAAWS-config.xml. The javadriver will look for the configuration xml
in this location .

NOTE:
If using a different name, remember to change the name configured in the
threads that communicate with CAA-WS. See the next section, “Configuring
XML in the hl7_soap_singreq Site”.

Configuring XML in the hl7_soap_singreq Site
1. Open Cloverleaf IDE.

2. Make sure you are at the hl7_soap_singreq or hl7_soap_multreq site.

3. Click on one of the java threads that communicate with CAA-WS.

4. At the Properties tab, click the Properties button.

The Java Driver Protocol Properties window opens.

5. Make sure the doStart method is selected and type the name of the
configuration xml file in the Argument field.

6. Select Skip JVM shutdown hooks when the thread exits.

7. Click OK.
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Adding an HTTP Conduit to the Configuration File
If the Web Service requires SSL (for example, if it is an https connection), then you need
to configure HTTP-conduit in the xml configuration file. An HTTP Conduit is created
with the helper dialog.

1. Open the WS Configurator tool and open the CCG-CAAWS-config.xml file.

2. Click Client > New HTTP Conduit.

The Add HTTP Conduit window opens.

3. In the Name field, type the Portname.

The portname from the SOAP Client tab can be used.

NOTE:
The portname should end with .http-conduit.

4. Click OK.

The Add HTTP Conduit window closes and a new tab for http conduit is added
in the Logical View and Physical View.

5. Use the information in the following table to complete the fields on the window.

HTTP Conduit

Field Value

TLS Secured Select the check box.

Secure Socket Protocol Select TLSv1.

Disable Common Name Check Select False.
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HTTP Conduit (cont'd.)

Field Value

SSL Cache Timeout Leave blank.

Key Password Enter the Certificate Password.

Keystore File, Password, Type Enter the information in each field, appropriate for
your system.
See “Creating an SSL Security Certificate” on page
17 for values for keystore fields.

Truststore File Enter the information appropriate for your system.
See “Creating an SSL Security Certificate” on page
17 for values for truststore fields.

NOTE:
Leave all of the fields in the Client Settings field blank.

NOTE:
If the Keystore is stored in the exec/process/[SiteName] directory, then
the entire path to the certificate is not required in the Keystore File and
Truststore File fields.

6. Select File > Save.

7. Open the XML configuration file in a text editor and ensure that the http conduit
section was added.

The HTTP Conduit can apply its settings to one or more Clients, or only to specific
URLs within a single Client.

The HTTP Conduit has children, such as Client, which configure TLS for those same
matched requests.

Review the Help section for a list of all Client properties.

Importing an XML Schema into Cloverleaf
Before the CCG is able to send or receive an XML message, such as the SOAP
messages used by an MPI web service, Cloverleaf requires a schema document that
describes the format of the XML message.
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Creating an XML Package in Cloverleaf
NOTE:

If using the XML package folderMPI_Schema shipped with the hl7_soap_multreq/
hl7_soap_singreq then this section can be skipped. The MPI_Schema shipped
with the template is for reference. It can be backed up with a different name and
the following steps can be used to create a new XML PackageMPI_Schema.

Use the following procedure to create an XML package in Cloverleaf.

1. On the CCG server, start the Cloverleaf IDE.

2. On the Tools pane, on the left side of the screen, click Configuration to expand
the Configuration tool bar.

3. Click the XML icon .

The CLOVERLEAF(R) Integration Services: XML Package Manager window
opens.

4. On the Server Package Viewer pane, highlight and right-click on the xml folder.
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5. Select New Package/Folder.

The Create a New Folder window opens.

6. In the New Folder Name field, enter MPI_Schema.

7. In the Folder Type: field, verify that XML is selected.

If XML is not selected, use the drop-down list to select it.

8. Click OK.

9. To view theMPI_Schema xml folder, you may need to expand the Host Server >
xml folders.

Generating XSD Files
Use the following procedures and information to generate XSD files.
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Why Generate XSD Files?
When you access a web service from the system, use the WSDL that describes the
web service the system is attempting to access. This creates an XSD file that describes
the messages you want to send back and forth.

You can compile the XSD file in a system XML package for creating transformations
between the SOAP messages sent to and from the web service, and whatever target
message format you use internally to process the request.

The XSD WSDL tool reads the WSDL, generates the XSD files for input and output
messages to the service, and compiles the newly-generated XSD files.

Before You Run the XSD WSDL Tool
The following tasks must be completed before running the XSD WSDL tool to generate
and compile XSD files:

• Both the system and CAA-WS must be installed properly.

• There must be an XML package directory.
See “Importing an XML Schema into Cloverleaf” on page 25.

• A command window must be open to the following directory:
CCG_INSTALL_DIR\quovadx\cis6.0\integrator\CAA\ws\tool\xsdWsdlToolClient.

• In the command window, run setroot.

• In the command window, run setsite hl7_soap_singreq or hl7_soap_multreq.

Running the XSD WSDL Tool
Use the following procedure to run the XSD WSDL tool to generate and compile XSD
files.

1. After setting the root and the site as referenced in “Before You Run the XSD
WSDL Tool” on page 28, in the command window run the following batch file
command to start the tool: xsdWsdlToolClientGUI.bat.

The interface opens and all entries are blank with theWSDL URI field selected.

2. Enter the URI to the WSDL you want to use.

3. Select one of the following check boxes:

• Show fully qualified names
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The names from the WSDL that have a namespace associated with them are
printed with the namespace prefixed before the name.

• Print WSDL contents after loading
Prints the WSDL text contents after loading.

4. Click Load WSDL.

The program attempts to read the WSDL from the location specified.

• If it cannot find the WSDL, an error prints in the Results section.

• If it finds the WSDL and can parse it, the Service drop-down field populates
with the list of services in the WSDL.

5. Select the appropriate Service from the list.

NOTE:
If there is only one choice in the drop-down list, it is automatically selected.

The Port list populates.

6. Select the appropriate Port.

The Binding and PortType fields display the name of the Binding and PortType
associated with the chosen port from the WSDL.

7. Select the Operation to invoke it.

The Input Message and Output Message are populated with the names of the
messages for this operation.

8. Select the Target XML Package.

This is the XML package in your site where you want to generate and compile
the XSDs.

9. Enter the Target XSD Filename.

The Full Input Filename and Full Output Filename fields display the full path
names of the resulting XSD files that are generated.

10. Click Generate and Compile Target XSDs.

This takes the selected settings, pulls the relevant information from the WSDL,
and creates two XSD files: Input and Output.
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These files have SOAP envelopes around the content chosen so transformations
in the system can generate the entire SOAP envelope to send to a web service
and parse the response SOAP envelope.

The system compiles the XSDs into OCM files, which are what the system uses
directly to allow translation in the given XML structure.

• If the generation or compilation fail, an exception message displays a
description of the problem.

• If the generation and compilation succeed, the result looks similar to the
following screen, confirming that the XSD generation and compilation were
successful.

NOTE:
The .OCM files and the .XSD files are generated by the tool at the following
location: <C:\gehc-it\ccg\quovadx\cis6.0\integrator\hl7_soap_singreq\
formats\xml\MPI_Schema>

Creating a Request Translation File
NOTE:

It has been observed that Clover Leaf XLATE doesn't always work with customer
provided XSD. TPS translation will be required if this does not work.

The mapping of HL7 and XML fields is dependent upon the customer site. This
procedure is a general guideline describing how to create a request translation file.
The ITPS team may need to be involved in creating a request translation file to
properly map the fields.

1. On the CCG server, start the Cloverleaf IDE.

2. On the Tools pane, click Configuration to expand the Configuration tool bar.

3. Click the Translation Configurator icon .

The CLOVERLEAF®Integration Services: Translation Configurator window
opens.
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4. Press Ctrl +N to create a new translation file.

The Choose File Formats window opens.

5. Select the following for Input Record Format:

• Format = HL7

• Version = 2.4

• Message = QRY_Q01

6. Select the following for the Output Record Format:

• Format = XML

• Package = MPI_Schema

• XML = [name of the XML schema]

• Root = [name of SOAP Envelope entity]
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The completed dialog box should look similar to the following screen:

7. Click OK.

8. Map the HL7 fields to the appropriate XML fields.

For example, map the QRD - Who Subject Filter - ID Number (which is the
Patient ID) to the request field that is to contain the Patient ID number). Work
with the ITPS team to complete this step.

9. The XML message requires you to define a number of constants.

As a minimum, you need to define the xml version, xml encoding and soap
envelope namespace (xmlns) fields. Work with the ITPS team to complete this
step.

Constants are entered by preceding the constant value with an equals sign (=).

For example, use the following values or XML version and encoding:

• Version =1.0.

• Encoding =UTF-8.
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You may obtain the constants needed for the soapenv:Envelope xmlns fields
from the XXXXRequest.xml file.

10. After the appropriate fields (including the soapenv:Envelope fields) are mapped,
save the file as Q01_to_XXXXRequest.xlt.

Creating a Response Translation File
The mapping of HL7 and XML fields is dependent upon the customer site. This
procedure is a general guideline of how to create a response translation file. The
ITPS team may need to assist in creating a response translation file to properly map
the fields.

1. On the CCG server, start the Cloverleaf IDE.

2. On the Tools pane, click Configuration to expand the Configuration tool bar.

3. Click the Translation Configurator icon .

The CLOVERLEAF® Integration Services: Translation Configurator window
opens.

4. Press Ctrl + N to create a new translation file.

The Choose File Formats window opens.

5. To create an Input Record Format select the following values for each field:

• Format = XML

• Package = MPI_Schema

• XML = [name of XML schema]

• Root = [name of SOAP Envelope entity]
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6. Select the following for the Output Record Format.

• Format = HL7

• Version = 2.2

• Variant = muse_IB_22

• Message = ADT_A19

7. Click OK.

8. Map the XML fields to the appropriate HL7 fields.

This step is customer-specific and varies from customer to customer. Work with
the ITPS team to complete this step.

As a minimum, the following ADT_A19 fields must be mapped:

• AA mapped to MSA.#1 (Acknowledgement code)

• Patient ID to PID.#3 (Internal ID)

• Visit number (or PID if visit number is not available) to PV1 (Visit Number)

NOTE:
Where there is a patient found error, the translation logic building the
ADT_A19message should leave the PID blank so that the hl7_soap_singreq
site's restore A19SiteID.tcl script can apply the proper MSA error coding.

9. When all of the required fields are mapped, save the file as
XXXXResponse_to_A19.xlt.

Configuring Cloverleaf Translation Routes
Use the following procedure to configure the Cloverleaf translation routes.

1. On the CCG server, start the Cloverleaf IDE.

2. On the Tools pane, click Configuration to expand the Configuration tool bar.

3. Select the Network Configurator icon .

The Netconfig tab opens.
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4. Right-click on the hl7_adtquery thread and select Thread Properties.

The Thread Configuration — hl7_adtquery window opens.

5. Select the Route Messages tab.
6. In the QRY_Q01 route folder, select soap_adtquery.
7. Double-click on the QRY_Q01 folder and highlight soap_adtquery.
8. Select Xlate and click Properties.

The Xlate Route Details window opens.

9. Next to the Xlate: field, click the List button.
10. Select the Q01_to_XXXXRequest.xlt file and click Apply.
11. Click OK.
12. Click OK to close the Thread Configuration window.

If a Create Directory window opens, click Yes.

13. Right-click on the soap_adtquery thread and select Thread Properties.

The Thread Configuration window opens.

14. Select the Route Replies tab.
15. Select Xlate and click Properties.
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16. Next to the Destination field, click the List button.

17. Select hl7_adtquery from the list.

18. Next to the Xlate field, click the List button.

19. Select the XXXXResponse_to_A19.xlt file.

The Xlate Route Details window opens.

20. Click OK.

21. Click OK to close the Thread Configuration window.

22. Press Ctrl +S to save the NetConfig.

23. Save the current CCG view by selecting View >Save Views.

Connecting the MUSE Site to the hl7_soap_singreq Site
Use the following procedure to change Cloverleaf sites and connect the MUSE site
to the hl7_soap_singreq site.

1. On the CLOVERLEAF(R)... window, select Server > Change.

If a warning message is displayed, click Yes.

The CLOVERLEAF(R) Integration Services window opens.

2. Select the muse_prod site and click Apply.

The Netconfig tab opens with a standard MUSE site displayed in the window.
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3. To connect the MUSE ADT Query feature to the MUSE prod site’smuse_adtquery
thread, as if the MUSE system were interacting with a HIS, follow the instructions
in the MUSE Cardiology Information System Installation Guide.
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4. Configure the properties ofmuse_adtquery to change Encoding to binary for
all countries which use special characters like Germany, Sweden, Denmark
and so on.

The default value is UTF-8.
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5. In place of a HIS, attach the muse_prod site’s his_adtquery to the
hl7_soap_singreq site.

To attach the sites, set the his_adtquery thread’s protocol properties Host to
local host and Port to 9100 as shown in the following screen:

6. Click OK to close the PDL TCP/IP Protocol Properties window.

7. Select View >Save Views to save the present CCG view.

Confirming CAA-WS and Cloverleaf Configuration
Confirm that the Infor Cloverleaf ®Integration Services 6.0 service is running.

1. On the CCG IDE Cloverleaf menu bar, change Cloverleaf sites by selecting Server
> Change.

If a warning is displayed, click Yes.

2. Select the hl7_soap_singreq server and click Apply.

3. On the Toolsmenu, select Runtime to expand the Runtime tool bar.
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4. Click the Network Monitor icon .

The Network Monitor tab opens.

5. Right-click on the button with the name of your process and select Control >
Startup to start the process.

In the following sample screen, it is the hl7_soap_singreq button.

6. Confirm that the processes and threads displayed change from red to green,
and that the threads display the status of either Opening or Up.

7. Right-click again on the green hl7_soap_singreq button and select Control >
Full.

The Process 'hl7_soap’ Cont... window opens.

8. Click EO config to change the Cloverleaf process logging level.

The EO Config window opens.
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9. Click List….

A dialog box opens.

10. Select enable_all_info and click Apply.

The EO Alias window opens.

11. Select enable_all_info and click Apply.

The EO Config window opens.

12. Click OK to close the EO Config window.

13. Do not close the Full Control window.

Click the watch output button.

The Watch Log file for process adtquery window opens containing log
messages.

If there is a problem with the testing, view this log to troubleshoot the issue.
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14. On the MUSE CCG CD, locate the HL7TestTool.zip file and extract the contents of
the zip file into your temporary directory.

The result should be an HL7TestTool directory containing HL7 test tool files.

15. On the MUSE CCG CD, locate the QRY_Q01.hl7 file and copy the file to your My
Documents directory.

16. Navigate to the HL7TestTool\bin directory.
17. Locate and edit the launchpad.bat file.

Edit the file by adding the JVM path of the CCG (c:\gehc-it\_jvm\bin\) to the
java command.

18. Save the launchpad.bat file.
19. Open an Explorer window.
20. Navigate and open the folder that contains the launchpad.bat file.
21. Double-click the launchpad.bat file.

The HL7 Test Tool:... window opens.

22. Select the Message Editor tab.
23. In the Remote System hostname field, enter the computer name of the CCG

Server.
24. In the Port Number field, enter 9100.
25. Click Select HL7 File, select the QRY_Q01.hl7 file that is in your My Documents

folder, and click Open.
26. Click Send.

If the HL7Test tool is issuing a connection error, you may have already activated
the muse_adtquery thread in the Cloverleaf muse_prod site . Complete the
following steps:

1. Shut down the muse_adtquery thread.
2. Return to the hl7_soap_singreq site.
3. Select Network Monitor.
4. Reopen the watch output window.

27. On the Cloverleaf menu bar of the Cloverleaf IDE, change sites by selecting
Server >change.
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28. Select the muse site.

29. Click on the Network Monitor icon .

The CLOVERLEAF(R) Integrarion Services: Network Monitor... window opens.

30. Ensure that themuse_adtquery thread is not running by confirming that it is red.

If the thread is running, stop the thread:

1. Right-click on the adtquery button.

2. Select Control > Shutdown.

31. Confirm that an A19 message with expected data is displayed in the response
window.

This is a version 2.2 HL7 message.

If that message is not displayed do the following steps:

1. Examine the Cloverleaf log window for error messages.

2. Correct the errors before continuing with this procedure.

32. On the Cloverleaf menu bar, change Cloverleaf sites by selecting Server >
Change.

If a warning window opens, select Yes.

33. Select the muse_prod site and click Apply.

34. Click the Network Monitor icon .

The CLOVERLEAF(R) Integration Services: Network Monitor... window opens.

35. Start the adtquery process:

a. Right-click on the adtquery process button.

b. Select Control >Startup.

36. Confirm that the adtquery processes and thread turn from red to green, and
that the threads display a status of either Opening or Up.
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37. In the HL7 Test tool, make sure that theMessage Editor tab is selected.

a. In the Remote System hostname, enter the computer name of the CCG
Server.

b. In the Port Number field, enter the port the muse_adtquery uses (the
default is 9005).

38. Click Select HL7 File.

39. Select the QRY_Q01.hl7 file in your My Documents folder, and click Open.

40. Click Send.

41. Confirm that an A19 message displays the expected data in the response
window.

The message should be a version 2.4 HL7 message.

Finalizing the Configuration
Use the following procedure to finalize the configuration.

1. Follow the instructions in the MUSE Cardiology Information System Installation
Guide to configure CCG Autostart.

Remember to add the hl7_soap_singreq site to the autostart script.

2. Add the hl7_soap_singreq site to the SmatCycle.

Performing Cleanup
Once the system is operating smoothly, you may archive or delete the temporary
files you created.

44 MUSE™ Cardiology Information System 2076576-008A



3
Troubleshooting

Use this section to resolve common problems you may encounter during the
configuration of the CCG MPI server. If your problem is not listed in the following table,
contact the ITPS team or the online center.

Common Problems
Following is a list of common problems and their solutions.
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Symptom Probable Cause Solution

No response, and the log
for the process displays an
error message similar to the
following:
[xpm :xlt :WARN/
0:adtquery_soaper_xlate:06/
04/2009 14:35:18] Message
encode warnings: Error
generated during parsing. –
Not enough elements to
match content model :
‘(soap:Header,soap:Body)’
for element ‘soap:Envelope’
– Line 1, Col 367

There are XML fields that
are not being defined in the
Q01_to_XXXXRequest.xlt
translation file.

Review the translation file
for missing constants or
mappings.

Site processes do not start. Use the following procedure
to reset Cloverleaf.
1. Switch to the site which

has this problem using
the Server > Change
option in the QDX IDE.

2. On the Runtime tab,
click the Shell window
to open up a command
prompt window.

3. Enter the following
commands to stop the
Monitor Daemon and
reinitialize the database:
hcienginestop -p
process_name
hcisitectl -K
hcidbinit -AC

4. Use the following
commands to restart
the hcimonitor and the
Lock Manager:
hcisitectl -S
hcienginerun -p
process_name
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Symptom Probable Cause Solution

No response, and the log
for the process displays
an error message similar
to: restoreMuseA19SiteID:
Invalid Patient ID...Squelch
Response... Check the error
database

The error message indicates
the ADT^A19message does
not contain a patient ID
number that matches the
original request. This may be
a PID mapping issue.

Monitor/Process does not
start after a system crash.

Use the following procedure
to fix Cloverleaf:
1. Change to the site that

has this problem using
the Server > change
option in the QDX IDE.

2. In the Runtime tab, click
on the Shell window to
open up a command
prompt window.

3. Enter the following
command to stop the
Monitor Daemon:
hcisitectl -K.

4. Change the directory
to the exec folder
and delete the
shared memory file
monitorShmemFile.

5. Use the following
command to restart
the hcimonitor and the
Lock Manager.:
hcisitectl -S
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Opening the WS Configurator Interface
Use the following procedure to open the interface.

1. To open the interface, double-click the jar file from a file browser or run
java -jar WSConfigurator.jar from the command line. This is found at
integrator/CAA/ws/tools/WSConfigurator.jar.

The program picks the default directory in which to read and save files by
looking at your environment variables and choosing the file that is present as
the default:

• $HCISITEDIR

• $CL_INSTALL_DIR

If neither of these files are present, the program looks for the home directory.

2. In the Logical View , open an existing configuration file (File > Open), or start a
new configuration file.
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Creating a New Client Configuration File
Start a new client configuration by adding Client logical objects.

1. Open theWebServices (WS) Configuator.

2. Select the Client tab.

A menu is displayed.

3. Use the menu to select the appropriate Client objects for your system.

Creating a New Server Configuration File
Start a new server configuration by adding new server objects.

1. Open theWS Configuator.

2. Select the Server tab.

A menu is displayed.

3. Use the menu to select the appropriate Server objects for your system.
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Using the Logical and Physical Views
After adding client and server objects, the Logical View looks similar to the following
screen:

The Physical View looks similar to the following screen:

Physical View Panels

Panel Description

Left panel A tree view displaying he structure of the XML document that you are
building.

Right panel The properties of any element that is selected on the left panel.

Bottom panel Context-sensitive help that displays help for the last time selected on
either side panel.
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After you save the configuration file, the name is displayed in the root node of the
Physical View.

NOTE:
From this point on, you can open the configuration file and continue editing it
using either view, or you can toggle between the two views at any time.

Editing a File
If the Client is deployed to another device, the WSDL must be available at the same
absolute path or it needs to be a relative path. Relative paths begin from the Java
Driver thread’s working directory.

For example, when the site has the working directory listed as WS under the site:

• If the WSDL is in that directory, set p:wsdlLocation to the filename of the WSDL.

• If it is in a subdirectory (for example wsdls), set the location to a relative path (for
example wsdls/myWsdl.wsdl).

When the site is deployed on another server, it uses the relative path within the site
instead of an absolute path that might not exist on that device.

NOTE:
This is not a problem for WSDLs at an HTTP URL, assuming the same URL is
available from both devices.

To edit the existing configuration XML from the hl7_soap_singreq site,
open the xml file from the path C:\gehc-it\ccg\quovadx\cis6.0\integrator\
hl7_soap_singreq\javadriver\hl7_adt_soap_singreq\using the WS Configurator.

Using the Logical and Physical View
There are two views that you can use to set up a configuration. The difference
between the Physical View and Logical View highlights the complexity of the XML
structure in the configuration file.

• Logical View
The properties of the Client are displayed on the right pane. Use this view to enter
or select the properties.
You do not need knowledge of the actual XML elements to set up a configuration
using this view.
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Hovering over a property opens a tooltip explaining the property. This provides an
easier view with which to work.

• Physical View
This view provides detailed descriptions of the XML elements and their meaning,
and displays what you can expect from the equivalent XML and the operations that
you can perform in that view.
Use this view as a learning tool to display how the actions taken on the Logical
View translate into the actual XML structure.

In this example, two elements were created (XML elements from the XML file the WS
Configurator generates):

• bean

• jaxws client

NOTE:
Some elements have properties that are displayed in the right panel when that
element is selected on the tree. These properties are attributes in the XML
file the WS Configurator generates.
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Creating and Deleting Elements
The right-click menu is where you delete an element and add child elements.
Right-clicking a Client element displays its available choices.

Selecting features creates an empty features element, as displayed in the following
screen:

At the bottom of the window, the context-sensitive help displays the features available
for this type of Client.

The SOAP Client supports WS-Addressing, which sends WS-Addressing headers having
appropriate values based on the WSDL and the message being sent, as well as a
logging feature that logs inbound and outbound messages.

1. To add features, select the features element.

2. Right-click the items you want to create.
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Using the Properties Child
A properties child element can exist under Client elements. This has a array of entry
elements under it that change the behavior of the Client in a number of ways.

When you select the key property of the entry, the Help information at the bottom of
the window provides a list of suggested values:

• Cloverleaf
Values starting with cloverleaf- affect how the Client interacts with the system.

• CXF
Other values come from CXF and modify CXF behavior. The system only lists
currently known ones.
You can enter other values found in the CXF documentation or code, even though
the interface does not mention them.

• Known values
Entering one of the know values and clicking the value property displays the
context-sensitive help for that key.
In the following screen, the valid values are displayed to set for the cloverleaf-trxid
property in order to control the trxID from the message in the system.
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Creating a New SOAP Server
Use the following procedure to create a new SOAP Server (Provider).

1. On theWS Configurator window, select Server > New SOAP Server.

The Add SOAP Server window opens:
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The help information at the top of the window explains the general flow.

2. In theWSDL URI field, enter the WSDL and any referenced XSD files within
the working directory for the Java driver thread (or a subdirectory of it) and
reference it with a relative path.

For example, a WSDL XDS.b_DocumentRegistry.wsdl is in the
WS/XDSb.Support.Materias.v10/wsdl directory, where WS is the working
directory.

If this service is deployed to another device and that same exact path does not
exist, the service cannot find the WSDL and fails to start.

3. Click Browse to locate the directory where WSDL is present.

4. Click the Load WSDL button to load theWSDL file.

The Service field is populated from the WSDL after it is loaded. If there is only
one entry, the interface automatically selects it.

The Port field is populated after selecting the Service. If there is only one port
using this service, it is auto-selected.

The Address field is for address overrides. You may leave this field blank.

5. Published Address is an optional field for populating the address in the
generated WSDL when a Client adds ?wsdl to the service address.

For example, a service resides on a device within a company’s
firewall named amagin42, but the outside world is routed into this
device using the DNS name cloud.amazing.com. If the service is at
http://amazing42/myservce, you can reach the WSDL within the network by
calling http://amazing42/myservice?wsdl. This generates a WSDL with the
service address as expected: http://amazing42/myservice.

This works for internal testing, but when the outside world calls it at
http://cllud.amazing.com/myservicce?wsdl, a public service address other
than http://amazing42/myservice needs to be returned or their Clients fail
without address overrides.
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In this case, enter http://cloud.amazing.com/myservice in the Published
Address field. The returned WSDL now has the correct service address to calling
users.

6. For Service Mode information, see step 7 in “Creating a New SOAP Client” on
page 21.

Using the Logical and Physical Views
The following information describes the Logical View and Physical View in the SOAP
Server.

• Logical View
The properties of this server are found on the right panel where you can enter or
select them from a drop-down list. Hovering over a property opens the tooltip that
explains the property.

• Physical View

NOTE:
The following screen display what you could see from the equivalent
Physical View and the various operations performed on that view, with detail
descriptions of many of the XML elements and their meaning.

This difference between the Physical View and Logical View highlights the
complexity of the XML structure in the configuration file and why the Logical
View provides a better view.

Endpoint Element
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The Physical View has one endpoint element, unlike a Client, which has a paired
bean element.

Similar to the Client element, the Endpoint element can have features and properties
children, corresponding to the fields selected or set in the Logical View.

To see the context-sensitive help, which is a list of allowable keys:

1. Select an entry in the left panel, and in the Properties panel, click key.

2. Click value to see the allowable values for that key.

Similar to the Client, the cloverleaf- named items are specific to working with the
system, and the rest are CXF generic values.
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View Trusted Certificates

View Certificates in the Trusted Root Certification
Authorities

Information is provided for using the Microsoft Management Console (mmc.exe) to
view the trusted certificates installed on your machine.

1. Click Start, in the Start Search, typemmc, and then press Enter.

The User Account Control window may open asking if you want allow changes,
click Yes.

Microsoft Management Console will open.

2. Click File > Add/Remove Snap-in.

The Add or Remove Snap-ins window opens.

3. In Available snap-ins, click Certificates, and then click Add >.

The Certificates snap-in window opens.

4. In This snap-in will always manage certificates for:, select Computer account,
and click Next.

The Select Computer window opens.

5. Select Local computer and click Finish.

6. If you have no more snap-ins to add to the console, click OK.

7. In the console tree, double-click Certificates.

8. Click the Trusted Root Certification Authorities store > Certificates to view all
the trusted root certificates on the machine.
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